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Chapter 1. About this document

This document is intended for application programmers or analysts working in an
IBM Application System/400 (AS/400) environment, who want to use the better
toolset provided in Development Studio Client for iSeries. It explains how to use
the Remote System Explorer, one of the tools provided in WebSphere Development
Studio Client, and compares this tool to the more traditional Programming
Development Manager (PDM).

The Remote System Explorer is a flexible, enhanced workstation version of PDM
that provides easy ways to perform everyday tasks when you use it with iSeries
projects.

» Create and manage development projects on your iSeries system from your
Windows-based workstation

e Connect to a remote iSeries server
¢ View iSeries libraries, files, and members

* Launch the server compilers, the workstation editor, a program verifier, and
various debuggers

This document introduces you to the similarities between PDM and the Remote
System Explorer. It also explains enhancements in the Remote System Explorer that
are not available in PDM, and describes how to accomplish the most commonly
performed tasks on your iSeries system using both methods.

The comparison between the two tools also helps you with the first step in the
iSeries Developer Roadmap: a learning path for iSeries developers who want to
adopt new technologies and improve their skills. For more information about the
iSeries Developer Roadmap, see
http://www.ibm.com/servers/eserver/iseries/roadmap/index.html.

To use this document effectively, you need to be familiar with basic Windows
tasks, such as file navigation and cursor manipulation.
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Chapter 2. Starting the development environment

Typically, an iSeries programmer connects to an iSeries server using a 5250
green-screen interface. The Programming Development Manager (PDM) can be
initiated from the AS/400 main menu or by typing STRPDM command on the
command line. The PDM menu is displayed:

-lofx]

File Edit Wiew Communication Actions ‘Window Help

)| ] B || ] % &t 5] @O

AS/400 Programming Development Manager (PDH)

[ ;.j I lconnected ta remate server/host borasD7m using port Z|pd101 on psprintl:pd101

Starting Development Studio Client

To start Development Studio Client:
1. Click Start on the task bar of your desktop

2. Select Programs > IBM Rational > IBM WebSphere Development Studio
Client for iSeries™ V6.0 > WebSphere Development Studio Client for iSeries

E IEM WebSphere Development Studio Client For iSeries 6.0 *|&% WwebSphere Development Studio Client For iSeries

Note: If the Advanced Edition of the product is installed on your workstation,
you will see the words "Development Studio Client Advanced Edition
for iSeries” in the Start menu.

3. If a window opens, specify the name of the workspace where you want to keep
your projects and other resources such as folders, subfolders, and files that you
develop with the Development Studio Client workbench.



X

Select a workspace

16M Rational Software Development Platform stores your projects in a directory called a workspace.
Select the workspace directory to use for this session,

C:\Documents and Settings|AdministratoriIBM\rationalsdps. 0YRSElabiX

Workspace:

™ Use this as the default and do not ask again

| oK I Cancel

(Optional) Type a unique directory name, for example, RSETabXX.
4. Click OK to start the workbench.

5. Click the X in the Welcome tab to close the Welcome view. You should see the
Remote System Explorer perspective.

File Edit Mavigate Search Project Run  Window Help

i |3 - Q-Q -~ | % 1 | EBremote syste..,

=) B ouine 33 N = 0J)

€| e Py | = x.-; e An outline is not available,

B unte Unix,
i+

- Ef Local

| Bremote ... 52 Tasl<s|15arias...|”:. =5

i
3% |

(s

[ Properties 2 . Remate Scrat:hpadl =i

. el

E 5P %
Property | Value |
Mame Mew Connection
Murrber of chi... 7
Type 4n expandable prompt fo..,.

| #&n expandable prompt .. .ckion: New Connection
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The workbench refers to the desktop development environment (IDE). The
workbench aims to achieve seamless tool integration and controlled openness by
providing a common interface for creating, managing, and navigating workbench
resources. Each workbench window contains one or more perspectives. A
perspective defines the initial set and layout of views in the Workbench window.
Within the window, each perspective shares the same set of editors. Each
perspective provides a set of capabilities aimed at accomplishing a specific type of
task or working with specific types of resources. For example, the Java perspective
combines views that you commonly use while editing Java source files, while the
Debug perspective contains views that you use while debugging Java programs.
Perspectives contain views and editors and control what appears in certain menus
and toolbars.

Opening the Remote System Explorer perspective
Check for the name of the perspective.

=101 %]

dt “NEVigate Search Project Run Window Help
| 5 - |4 -0 - @ - |2 E{EiERemnte Syste...

=gl || B= outiine gN_ 70
| |&n outline is not available.

I3 iseries. ..
- Windows...
@ _& Liree, ..

If you see a different perspective from the Remote System Explorer, or no
perspective at all, then select Window > Open Perspective > Remote System
Explorer from the workbench menu bar.

& Remote System Explorer - IBM Rational Software De =10| x|
File Edit Mavigate Search Project Run | ‘Window Help
|5 - [3 - QO - @ - _ New Window | EBremote Systs...
‘ E}iﬁeﬂes Projects Open Perspective
| ® ®E Remote System Explorer K yen = éutine 3@ ':'E
[ WebFacing Customize Perspective... | yne s not avalable, |
= . = —————| Sawe Perspective As...
Other... Reset Perspective
P iSeries... Close Perspective
| B & Windows... Close &ll Perspectives
LoD Linux..,
o w- N Power Linux,.., Navigation b
i B uni Unix... Preferences
.- ATY

For the exercises in this document, you will work in the Remote System Explorer
perspective, which is designed for iSeries programmers. This perspective is where
you can create new connections to an iSeries server, work with iSeries files,
commands, jobs, and integrated file system files.

This perspective is active when you start Development Studio Client, loaded with
a new workspace. If you have used a workspace before, the workbench opens with
the perspective that you last used. You use this perspective to launch the iSeries
programmer tools and views in the workbench.
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Configuring a connection and connecting to an iSeries system

When you first open the Remote System Explorer, you are not connected to any
system except your local hard drive on your workstation. Before you can connect
to a remote iSeries server, you need to define a connection. When you define a
connection, you specify the name or IP address of the remote system and you give
the connection a unique name that acts as a label in the workbench, so that you
can easily connect and disconnect. When you connect to the iSeries system, the
workbench prompts you for your user ID and password on that server.

The first time you connect to an iSeries server, you need to specify a profile. All
connections, filters, and filter pools belong to profiles. We will discuss profiles after
you create your first connection.

To configure a connection:

1. In the Remote Systems view, New Connection is automatically expanded to
show the types of various remote systems you can connect to through the
Remote System Explorer. Click the plus sign (+) beside iSeries to configure a
connection to an iSeries server.

- Lo,
P ﬁ Power Linux...
- [ unix Unie...

L ALK

| @B Local...

= E—j Local

2. In the Name personal profile page, leave the default value in the Profile field
and click Next.
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x

Name personal profile

Uniguely name user profile | I

Welcome to Remate Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members, You wil
decide for each new connection whether it is owned by the team profile or your
profile,

Praofile: | msteckh7tp

3. On the Remote iSeries System Connection page, specify the information for
your connection.

x

Remote iSeries System Connection

Define connection information | I

Parent profile: |mstedd1?tp j
Connection n 5400a

Host name: | s400a] } -,J
Description: h g

riFv host name

<Back | MNext> r@1 Concel |

4. In the Host name field, type the IP address or the name of your server system,
for example, s400a.

The Connection name is automatically filled with the server name for your
convenience. This name is listed in your Remote Systems view and must be
unique to the profile, so you probably want to accept the default value.

5. Leave the default value for the Parent profile field. For this exercise, you can
accept the default parent profile to keep your files private. For future
development, you can choose to share your files and resources by selecting the
Team profile.

6. Leave the Verify host name check box selected.

Chapter 2. Starting the development environment 7



7. Click Finish to define your connection.

After you configure a connection to an iSeries server, you can easily connect and
expand your new connection to reveal your subsystems. Subsystems are
predefined filter groupings of the various types of remote resources that can be
explored in the remote system. Your iSeries connection gives you access to four
subsystems:

* iSeries Objects is a PDM-like group, enabling access to libraries, objects, and
members

* iSeries Commands contains predefined commands you can run against remote
objects. You can also create command sets, each of which contain one or more
frequently used commands. When run, all commands in a command set are sent
to the remote system and executed, and the results are logged in the iSeries
Commands log view

* iSeries Jobs displays various jobs, subset by job attributes, and enables you to
perform a number of operations on those jobs.

* |IFS Files helps you explore folders and files in the Integrated File System of the
remote iSeries server.

=14 New Connection

. B-Hg iSeries...

[ lv| Connection created successfully,
L E- Y Windows...
P & Liruz, ..

B 0y Power Linux...
P Feunie UK.

LB ALK

- #E Local...
'+E Local

=g s4005

ecks

Work with libraries. .,
- Work with objects...
-3 Work with members. ..
el % Library list
-3 User libraries

[+ g iSeries Commands

[ @b iSeries Jobs

- Ty IFS Files
5 Qshells

4 | )|

To connect to an iSeries system:

1. In the Remote Systems view, your new connection is automatically expanded to
reveal your subsystems. The iSeries Objects subsystem is the subsystem you
will use most often. It is very similar to PDM, in that it allows you to access
objects in the QSYS file system and perform actions on those objects.

2. Notice that the first three entries under the iSeries Objects subsystem are
named after PDM options, because they have similar capabilities:

» Work with libraries (similar to WRKLIBPDM)
* Work with objects (similar to WRKOBJPDM)
* Work with members (similar to WRKMBRPDM)
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In addition, there are entries for working with library lists and user libraries:
» Library list (similar to STRPDM, Option 1, *LIBL)
* User libraries (similar to STRPDM, Option 1, *ALLUSR)

A closer look at the user interfaces

The most obvious difference between PDM and the Remote System Explorer is the
user interface. PDM is text-based, while the explorer is a graphical user interface.
Although the interface looks different, the underlying features are similar.

To apply an action to an object in PDM, type the number of a particular action
beside the object (in the Opt column) and press the Enter key.

=0 Session A - [24 x 80] Mi=]1E3

File Edit View Communication Actions ‘Window Help

Bl B Ak Bl @ it 260 @l el

14 /7803

217 (1902 - Session successfully started

~
e

In the Remote System Explorer, right-click on the object and select the action you
want from the pop-up menu.
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~, 7

Team[ = ||

17 Remote Systems X

@[5 CLCL*pgm.clle |
& [#] CLR1.*pgm.clle

MYCOMPILE. *pgm.clle
PAYROLL, *pgm.rpgle
PAYROLLCZ . *parn.cblle
PAYROLLD, *pam. chlle
£ [£] PAYROLLG.*pam.rpgle
[} RSE17751.*dtaq

- Ely COMPARE *file.pf-src
#-[E EMPMST.*flle.pf-dta

’ EYFEVENT, *file.pf-dta
51545 MSTDSP, *file. dspf
-5 MSTDSPZ, *file.dspf

E:r,' PRIMST , *file,pf-dta
&1 Ely QCBLLESRC *file. pf-ste
#-Eh) QCLSRC. *file.pf-sc
51-Ely QCMDSRC. *file.pF-sre
#1-Ely QDDSSRC. *file. pf-sre
= Ely QRPGLESRC, *file. pF-sr
] IERPAYROLL rpols

.oy PAYROLLGp; GO To ’
- Ely QRPGLESRCP, *file
- h
@ [ REFMST *fle.pf-d P ,
* RSMMST . *file.pf-c Browse With
" MYCOMPILE.*crd
] i i M oern, #ik evad e 'I'“:Rename'"
4

(properties 53 . Remote Scratchoad <5+ Move...
PDM has display screens that list libraries, objects, members, and user-defined

options. There are two ways to get the same display list in the Remote System
Explorer, the Remote Systems view and the iSeries Table view.
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@ Remote System Explorer - 16M Rational Software Development Plat = =] 3
Fil= Edit Mavigate Search Project Run  Window Help
Cl- ] ‘f,i‘k - 0 - % - J 5 ‘ g v v B iﬁRemateSyste...
BHRemote Systems £3 \\Taarn| ] | OF Outline £3 _\\5 =
4 8 | 2 T s - An outling is not available.
=57 New Connection
= Fig iseries. ..
Iv| Connection created successfully. |
[+ Windows
B _& Lirnx
#-{) Power Linux..,
i Ui,
By AlK..,
#-E Local...
E—j Local
=B s400a
= & iSeries Objects
¢ 28 work with lbraries. .
-7 Work with objects. ..
28 -Kj' Work with members. ..,
EI--@ Libraty list
| E-g User lbraries M — T
-k iSeries Commands Tasks 1Lyl PR [Series ... lR.emote i i
5 % iSeries Jobs liSeries Table View ’E o @
s t-? ok ilse this view to display a list of items, for example, mem.,, 4
Lo Qshells a table Farmat similar to FOM, You can also perform actio. .,
as editing and compiling,
4
I I —'] You can populate this view by either clicking the solid bla,,, =
" = N = of this view and selecting Work with > Members or Wark ...
" Properties £2 - Remate SU"_'EChD‘“d[ = ar by tight-clicking a parent object from the Remate Syst... =,
=, T.
B~ qJ" | »|
Property ] Value alllw
Connected Yes .
Mame iSeries Objects Cammand II'-Jnr‘.‘n-‘:F z‘ I
Mumber of chi... &
Prrt n 2 M +| Detalls,.. | She
d WOk el e o
I |

In PDM, you perform actions on

an object by specifying an option in the Opt field

next to the object. Generally, to perform actions against items in the Remote
System Explorer using the table view, you can right-click the item and choose from
the list of available options shown in the pop-up menu.

R I iseries Table view: X, Run #s ¥ bte System Details | =]
Library RSELABXY, (23 Objects) Run(Prompt) * EED o DG v
Debug(Service Entry) » Sl
_Name | Type R 5 | status |~
Bl CLc *PGM Debug (Prampt) » Dable, calls Payralld, par.., ©K =
(=] cLr1 *PGM able, calls Payrallg, par...  OK
[£] MYCOMPILE *PEM OK
[fPayrROLL m
[#] PAYROLLCZ *PEM CBLLE with verify errors QK =
| ' | _,[-I

PDM allows you to apply the same operation to more than one item at a time.

11
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=1 Session A - [24 x 80]
File Edit View Communication Actions ‘Window Help

Work with 0Obje: g PDM

More...

<J7 (1902 - Session successfully stated v

In the Remote System Explorer you can select multiple objects and apply the same
operation to these objects simultaneously. To apply an action to multiple items in
the Remote System Explorer:

1. Expand the filter that contains the items.
2. Select the items you want.

» To select consecutive items, click the first item, press and hold down the
SHIFT key, and then click the last item.

: Tearnl =0|
| 8 & g (=

[F] PAYROLLG. *pom.rpgle |
[J: RSE17751.*dtaq
m By comMPaRE.#file.pf-src

[ [ EVFEVENT.*file.pf-dta
[l 6% MSTDSP. *file. dspf
-6 MSTDSP2. *file. dspf

- 5] QCLSRC. *Fils.pf-src
- By QCMDIRC, *file.pf-src
- Ey QDDSSRC *file pf-sre
=1-[E) QRPGLESRC. *file. pf-src
-
Iy PAVROLLG.rpgle
=-1Ey QRPGLESRCP. *file. pf-src
05 PAYROLL.rpale
PAYROLLG.rpale
REFI\‘ET.*fiIe.pF-dta
[E RSNMST *file.pf-dta
B MYCOMPILE *cmd

| i] QGPL Hib.prod-usr =
rer B nre AP B Lo b e

» To select non-consecutive items, press and hold down the CTRL key, and
then click each item.

» To select all the objects in the window, on the Edit menu, click Select All.
3. Right-click and select the action to apply to these items from the pop-up menu.

&

H
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(T}
Jar

<

BK

[+ [#] PAYROLLG.*pagm.rpgle
[: RSE17751.*dtaq
1[5y COMPARE. *file.pf-src
5[5 EMPMST *file.pf-dta
- [E EVFEVENT.*Flle.pf-dta
[ 6% MSTDSP, *file. dspf
&1 6% M5TDSP2, *file. dspf
-5 PRIMST *file.pf-dta
1 [Ely QCBLLESRC, *File. pf-src
- [Ey QCLSRC. *file.pf-src
& [Ely QCMDSRC *file.pf-stc
1 Ely QDDSSRE, *file.pf-sre

= E] QRPGLESRC, *file.pf-src

| i (_h Pi o gle e
&1 Eh QRPGLESRCP. *file.p

An oul

- [l REFMST.*file.pf-dta
1[5 RSWMST *file.pf-dta
- B MVCOMPILE. *cmd

Bl WRLABRY *ibtest-usr Copy

Open With

Browse With L4

-l WSSLABKR Mib.prod-use

o TR b b enie

]

¥ Delste,..

In PDM you can use the Prompt (F4) feature in some options to specify additional
parameters. In the Remote System Explorer, after certain actions, like the PDM
prompt, a wizard prompts for additional information.

The next chapter contains more concrete examples to help you explore additional

differences in the user interface.

Chapter 2. Starting the development environment
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Chapter 3. Entering commands using the command line

When you use PDM you can enter commands directly on the command line.
Similarly, you can type any valid commands in the command line of the Remote
System Explorer using the iSeries Table view.

The iSeries Table view shows the same information as the Remote Systems view,
with the added ability to sort items, view descriptions, and perform other
PDM-like actions.

You can see the properties of all items at the same time, with each item as one
row in the table.

The selected file, library, or filter in the iSeries Objects subsystem is input for the
table when you select the Show in Table option from the pop-up menu.

Work with actions from the iSeries Table view populate the view with libraries,
objects, or members.

You can perform actions against these items, such as editing and compiling.

To populate the iSeries Table view, you can either:
» Click the menu icon at the top of the view and select Work with and the type of

items you want to work with.

Tasks | NET R R TIea iSeries Commands Log | Remote System Details | =8|
Library RSELABXX (23 Objects) E._ o) &
_Hame | Type | Attribute  Libraries. .

Flccy PG CLLE Objects... _;ubs ot

1 CLRA *PGM CLLE Members. . i

&l MVCOPILE “PGM CLLE v Objects: RSELABRY <s400a> Show columns

HEPAYROLL | RpGLE Mt Position to, . i

[£] PAYROLLC2 *pEm CBLLE with verify errors sl

[#] PAYROLLD *PiEm CBLLE no errors Prink...

[£] PAYROLLG PG RPGLE Export to File...

[irsE17751 *DTAQ Hide Commands
Ehcompare *FILE PF-SRC ——Frm—. ||

= Preferences...

& EmemsT *FILE PF-DTA

B evrevenT *FILE PE-DTA oK

ﬁ?:iMSTDSP *FILE DSPF with no errars oK

EhimsToSP2 *FILE DsPF with no errors oK

&l promsT *FILE PE-DTA oK

=y qeeLLEsRe +FILE PF-SRC oK

Ehoasec *EILE PF-SRC oK

[l gompsre *FILE PF-SRC oK

Eyqoossrc *EILE PF-SRC oK

EhorpaLESRE *EILE PF-SRC oK

EygrralEsrRce  *FILE PF-SRC oK

& RermsT *EILE PE-DTA oK

B rommsT *FILE PF-DTA oK

BB MYCOMPILE D oK

w

Command |Narmal j | ;] Promipts | ‘P_JFJ
Messages | _vj Dekalls, | Show Lag... |

Or, right-click a parent item, such as a library or object, in the Remote Systems
view and select Show in table.
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Teal

" "-' Remote Systems %

S|
By ALR...
=& Local...
#-Ef Local
=-F& s400a
=l §h iSeries Objects
+- 2% Work with lbrari
"J" ‘Work with objec
'45' Wwork with memt
i") Library list
W Qsvs.*ib.pr
=il QsYs2.Mib.
= il QHLPSYS. i
W Qusrsys.H|

i

& Remove Fram Library List
4 Move Up In Library List

<+ Move Down In Library List
1+ Move Within Library List..,

& Find String...
Change...
SavelB)...
Restore{I)...
User Actions

Create iSeries Project(K)

Properties(L)

=3 ﬂ\\, RS

In general, to perform actions against items in the workbench, right-click the item
for a list of options.

After populating the iSeries Table view, you can access the command line. You can
type the command and click Run or Prompt. The iSeries Commands Log view
automatically shows you any feedback.

ﬁarbas:mmdsmglnemmwmbetaxkl =50

15 S I iseries Table view. X

Library RSELABXY (23 Objects) |LLT_ S E @
_Name | Type | attribute [ Text Istas| [ [ |
[#] gt *piEm CLLE debuggable, calls Pavrolld, par.,, OK
[®] CLR1 *pigM CLLE debuggable, calls Payrollg, par.,. ©OK
[#] MYCOMPILE *PGM CLLE 0K
la2fpavROLL Reglte | Jox [ [ [}
[ payrOLLC2 *PGM CELLE with verify errors oK
[£] PAYROLLD *PGM CBLLE N0 BITors oK
[l PayROLLG *PGM RPGLE oK
[irsE17751 HDTAQ oK
Ehycompare *EILE PF-SRC oK
& EmemsT *FILE PF-DTA % oK
& eveevenT *FILE PE-DTA oK
EimsTDSP *FILE DSPF with no errors oK
6’ﬁ‘-jIWSTDSPZ *FILE DSPF with no errors QK
& promsT *+EILE PF-DTA oK
E‘] QCBLLESRC *EILE PF-SRC oK
Ehaqcisre *EILE PF-SR.C oK
Eh ocmpsre *+FILE PF-SRC oK
Eyqoossre *EILE PF-SRC oK
EyoRPELESRE *FILE PF-SRC oK
[EyQRPGLESRCP  *FILE PF-SRC oK
REFMST *EILE PF-DTA oK
[ rRstumsT *FILE PF-DTA oK
B MYCOMPILE *CMD oK

S

Command |Narmal

j I :] Erompte. |i]

j Diekalls, ] Show Log... |

Messages |

You can also click on the cyan arrow to hide/show the command area.
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Listing detailed messages

When you use PDM you can view useful messages that are generated when you
enter commands on the command line if you use the list display mode. Similarly,
you can view detailed messages that are generated from the iSeries Table view
command line by clicking Details.

Tasks | TR E= Ve 3 iSeries Commands Log | Remote System Details I =50
Library RSELABXY (23 Objects) & G @m
_Hame | Type | attribute [ Text [status| | [ |
[#] gt *piEm CLLE debuggable, calls Pavrolld, par.,, OK
[¥] CLR1 *pigM CLLE debuggable, calls Payrollg, par... OK
[] MYCOMPILE *PiGM CLLE oK
[E] PAYROLL *PGM RPGLE oK
[Fl pavROLLCZ *pGM CBLLE with verify errors oK
[£] PAYROLLD *PGM CBLLE no errors oK
[E] PAYROLLG *PGM RPGLE oK
[irsE17751 *HDTAQ oK
Ehcompare *FILE PF-SRC oK
& EmemsT *FILE PF-DTA oK
EVFEVENT *EILE PE-DTA oK
EimsTDSP *EILE DSPF with no errors oK
f"'P—ﬁl\ﬂSTDSPz *FILE DSPF with no errors QK
&l promsT *FILE PF-DTA [%. oK
EyqeeLLEsRe *FILE PF-SRC oK
Ehoasec *EILE PF-SR.C oK
[l gompsre *EILE PF-SRC oK
Eyqoossrc *EILE PF-SRC oK
EoRpaLESRE *FILE PF-SRC oK
EhQRPGLESRCP  *FILE PF-SRC oK
REFMST *EILE PF-DTA oK
[ rstmsT HFILE PF-DTA oK
B MYCOMPILE *CMD oK
w
Command |Narmal ;l I :] Praipti.. | M
Messages |Current library changed to RSELABKX, j Show Log... |

Retrieving commands

Retrieving commands (F9) saves you from retyping the same commands in PDM.
This feature is also available in the iSeries Table view. Press F9 to retrieve a
command on the command line in the iSeries Table view. You can also add
parameter values to the command or modify parameter values for the command.
You can press F4 (Prompt) or click Prompt to prompt the display for the

command.
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EwhstmsdsLoglRMSymoetaﬂs[ =50

{aeries 1able

Library RSELABYX (23 Objects) IF S & D -
Name [ Type [ attribute [ Text [stas| [ | |
Eloc *piEm CLLE debuggable, calls Payrolld, par.., ©OK
®l LR *PEM CLLE debuaggatle, calls Payrollg, par...  OK
MYCOMPILE *PGM CLLE oK
(=] PAYROLL *PGM RPGLE oK
[F] payROLLCZ *pEm CRILE with varifu avvere Hald
[#] PAYROLLD el @ change Current Library (CHGCURLIB) 5'
] PAYROLLG *PGl curent libeary:

[irsE17751 *OT,

Eycompare *EIL

EMPMST *EIL

T EvrEVENT sepL I Adyanced [~ AlParameters [ Keywords
EdimsToSP L

o2 CHGCURLIB CURLIB(RSELA) =
6 iMsTDSP2 WEIL i) =
PRIMST *EIL %
EyqceLLEsre *FIL
Ehaqcisre *EIL
Ely qcmpsre *FIL
Ejqpossre FIL | oK | Restore defauis | cancel |
EyoRPGLESRE *FIL

EjqrrelEsrce  *FILE PF-SRC ok
REFMST *FILE PF-DTA [:% QK
RSMMST *EILE PF-DTA oK
B My COMPILE *CMD Ok
w

Command ]Nnrmal ;I |chgcurlih reelaboce j Fll.nl

Messages [Current lbrary changed to RSELABX, ~] Detais... | showLog... |
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Chapter 4. Objects, libraries, files, and members on the
iSeries server

As you know, objects are the basic unit on which commands perform operations on
the iSeries server. An object is a named unit that consists of both a set of features
that describe the object and a value. The features of an object include its name,
type, size, the date it was created, and a text description. The value of an object is
the collection of information stored in the object. The value of a program for
example, is the runnable code that makes up the program. The value of a file is the
collection of records that make up the file.

There are many types of objects. For example, the object type of a library is *LIB,
the object type of a file is *FILE, and the object type of a program is *PGM. Objects
can also have subtypes known as attributes, which are the characteristics of the
objects. For example, the attribute of an object of the *PGM type could be RPG, to
indicate that the program is created using RPG source code. The attribute of an
object of the *FILE type could be DSPF, to indicate that the file is a display file.

A library is a special type of object that is used to group related objects. A file is an
object of the *FILE type that has an attribute that describes the type of file (source
physical file, data file). A member is a subset of records in a file. Each member
conforms to the characteristics of the file.

The following table shows how to do each task in PDM and the Remote System
Explorer. For more information, see the tasks that follow.
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Accessing iSeries objects

Filters

The following examples show you how to use the Remote Systems view to access
iSeries objects. Optionally, you can use the iSeries Table view to accomplish the
same task by using the Work with option from the drop-down menu.

Tacks [N oR T T eun, iseries Commands Log | Remote System Detais =8|
Library RSELABXY (23 Objects)
_Name ] Type j Attribute  Libraries. ..
Flact PG CLLE Objects...
[F] CLR1 *PGM CLLE Members. .. ZE
ElmvcomerLe . “PEM CHE v Objects: RSELABRY <s400a> Show columns
: RPGLE TS Position to. .. =
[£] PAYROLLC2 *pEm CBLLE with verify errors sl
[#] PAYROLLD *PiEm CBLLE no errors Prink...
[£] PAYROLLG *PGM RPGLE Export ta File...
[irsE17751 *DTAQ Hide Commands
.@] COMPARE *FILE PF-SRC e |
- Preferences...
& EmemsT *FILE PF-DTA
ﬁ EVFEVENT *FILE PE-DTA CK
ﬁ?:iMSTDSP *FILE DSPF with nao errors oK
EhimsToSP2 *FILE DsPF with no errors oK
@ PRIMST *FILE PF-DTA oK
EjqceLLesrc *FILE PF-SRC oK
Ehoasec *FILE PF-SRC oK
Eh ocmpsre *FILE PF-SRC oK
E] QDDSSRC *FILE PF-SR.C QK
@] QRPGLESRC *FILE PF-SR.C Ok
EygrralEsrRce  *FILE PF-SRC oK
E REFMST *FILE PF-DTA OK
B rommsT *FILE PF-DTA oK
B MYCOMPILE *CMD QK
w
Command |Narma1 j | ;] Promipts | ‘P_JFJ
Messages | _VJ [etzlls, | Show Log... |

in the Remote System Explorer

In the Remote System Explorer perspective, you can use filters to query your
iSeries server to list and perform actions upon libraries, objects, and members.
Think of filters as a way to perform the same action you might be accustomed to
in Program Development Manager (PDM) to work with libraries (WRKLIBPDM),
work with objects (WRKOBJPDM), or work with members (WRKMBRPDM). The
Remote System Explorer perspective is designed to mimic these PDM actions, and
perform many additional actions not possible in PDM.

When you create a filter in the Remote Systems view by expanding Work with
libraries, Work with objects, or Work with members, your selections in the
filtering wizard create a filter string. For example, you can define a filter string to
query all members of the *rpgle type in your current library. After you define your
filter, you can re-open it to add another filter string, for example, to also find
members of the *mnucmd type in the same library or a different library. When you
access the list by expanding the filter, you can see the Native iSeries File System
items (libraries, objects, and members) and perform actions (such as editing,
compiling, running, and debugging) on these remote items.
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Filters are persistent -- when you reopen the workbench at a later time, the filters
that you created earlier are still available.

Viewing a library list
To view the library list (*LIBL and *USRLIBL) in PDM:
1. Select option 1 (Work with libraries) from the PDM menu.

2. Press Enter and type one of the options provided in the prompt to display the
list.

In the Remote System Explorer, library list filters display the *LIBL library list from
your iSeries server in the Remote Systems view. When expanded, the filter
provides the same actions as a library filter, with additional actions for
manipulating the library list.

Note: If you are using your default profile, the wizard assumes that you already
have a library list. Therefore, this action only applies if you are using a team
profile, or an additional personal profile.

To access your library list in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects. Right-click iSeries Objects and select New > Library List Filter.

Note: This action corresponds to the EDTLIBL command in PDM.

.15 Remote Systems X Ieaml =8| || 5= out

S noih

£

[=-.4° Mew Connection
=B iseries...
! lv| Connection created successfully. Exp:
A windows.,. .
_ﬁ L.
-\ Power Linux...
Unix Unix..,
- BB, ALK
#-El Local...
=-Ef Local
= B s400a

= iSeries Cbjects

B

3

% T ko ] ..

—_— " s
L Work with Go Into
B workwith oo »
il Library lis 5 Library Filter. ..
P =l e

a'iﬂ:" User libra / Open Member. .. - Object Filter. ..

# iSeries Comm e . ;
& iSeries Jobs l‘_E o I ow Rl 3 Member Filter...

2. Enter a name for the filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.

3. Select the Only create filter in this connection check box if you want the filter
to display only in your current connection. Otherwise, it displays in all your
connections.

4. Select the profile you want to use for this filter. You can use an individually
created profile to keep your work private or the team profile to share with
others. In this instance, use your team profile.
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@rew x|
Library List Filter
. O 1
Create a new iSeries library list filter -y |,

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appear in the Remote Systems view, and will be expandable,

Filter name: | Team Library Lisk

I Orily create filter in this connection

Select 3 profile ko own the new filter, This determines if it is unique to you, or
charable by the team. It will be placed in the default filker pool for that profile.

owner profie: R ~ |
cpak | mext> || Fish | Cancel |

5. Click Next and click Finish.

6. You can see your new library list filter in the Remote Systems view under
iSeries Objects.

L& Remote Systems X

£ &) $ | B v
=14 Mew Connection
. Bl iseries...
~-[¥] Connection created successfully, Exp:
@Y Windows...
& A Linux...
w1 {y Power Linux...
Bwnix LR, .
-y ALX...
¢ #-E Local...
& B Local
=-fif s4008
= En iSeries Cbijects
[ *& Work with libraries. ..

1+

-7 Work with objects., .
&3 Work with members. . Rv
i Library list
T+ ﬁfx‘* User libraries
] ﬁ Te ary List

[+ {Series Commands

[ @8 iSeries Jobs

) *}y IFS Files

% Qshells

4] | 2

Tip: You can drag and drop filters from one subsystem or filter pool to another, as
long as they have the same subsystem type. Also, if you drag a filter into
another filter, the target filter is updated with filter strings from the first filter,
to combine them.

Viewing a library
To view a list of libraries (*ALL, *ALLUSR, *CURLIB, name, *generic) in PDM
1. Select option 1 (Work with libraries) from the PDM menu.
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2. Press Enter and type one of the options provided in the prompt to display the
list.

Library filters list a set of libraries from your iSeries server in the Remote Systems
view. To access a list of libraries in the Remote System Explorer:

1. In the Remote Systems view, expand your connection and then expand iSeries
Objects> Work with libraries.

2. Expand Work with libraries.

B &7 Mew Connection
El- EB iSeries.,

L Cnmectiun created successfully, Expe
@Y Windows...
& Linux..,
w1 ) Power Linux...
B upie Unix...

-y ALX...
=B Local...
“Ef Local
. s400a

g _}) Wiork with mernl:ers
- ﬁ« Library list
] 3‘1" User libraries

) gk iSeries CQmma'chs
= a iSeries Jobs
- ¥y IFS Files

=

La Qshells

4] | i

(You can also right-click iSeries Objects, or your filter pool, and select New >
Library filter.)

Team | =l o= Outlin

& 8 - | = ‘2 — An outling

F1 47 New Connection

= -l'n iSeries, ..

: [¥| Connection created successfully. Expe

- windows...

#l A Lirws. ..

* & Power Linux...

]t LTI,

G AIX... '

#-E Local... |
& Ef Local |
=8 1 s400a |

2, Work with | Mew
oy

» m\ Library...
B8 Workwith ¢ Go Into 5 Library List Filter...
[+ 4] Work with GoTo -

»
[+ }v User librarie / Open Member... :Ar;r Object Filter...

-l Team Librat £ open in New Window 24 Member Filter, .
+J ﬁi( iSeties Commar __ ain

Note: Expanding Work with libraries corresponds to the WRKLIBPDM
command in PDM, and it also creates and expands the filter in the
Remote Systems view.
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3. Select a generic or specific library name from the Library drop-down list, or,
type a generic name such as Y* to list all libraries that start with V.

I x|
Library Filter
Create a new Series library filker #1 N
* | v

Library: |‘r"" ;I ﬂ Browse. .. I

< Hack I Next > I Finish | Cancel I

You can also click Browse to locate libraries. Click Next.
4. Enter a name for your filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.
5. Select the Only create filter in this connection check box if you want the filter
to display only in your current connection. Otherwise, it displays in all your
connections.

[ x]
Library Filter
Mame the new Filker #1 N
s il

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appear in the Remate Systems view, and will be expandable,

Filter name: | ¥ Libraries| L

I Oy create filter in this connection

Select 3 profile to own the new filter, This determines if it is unique to you, or
sharable by the team, It will be placed in the default filker pool for that profile.

Owner profile: |mstackh?tp _'J

<Back | mext> || Fish | Cancel |

6. Select the profile you want to use for this filter. You can use an individually
created profile to keep your work private or the Team profile to share with
others. In this instance, use your default private profile.

7. Click Next to see more text information about the filter or click Finish.
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Your new library filter now displays in the Remote Systems view under iSeries
Objects.

[=1--&° New Connection A
B rB iSeries...
|| Connection created successfully, E
@Y Windows...
& Linux..,
w4 Power Linux...
B unie Unix...
-y ALX...
#-E Local...
F;? Local
B 54008
= fﬁ iSeries Cbijects
A5 Work with libraries. .. [}\
- wwork with objects. .
3] "ﬁﬁ ‘Work with members. ..
i+ -'ﬁ’ Library list
] }:’v User libraries
'y

SR Libraries

¢ @l YANTZI Mib prod o
- @l YANTZILAB.*ib.prod
B YANTZITST #ib.prod

i+ i Team Library List =
i T Ry S
4| 1 3

Viewing a list of objects
To view a list of objects in PDM:
1. Select option 2 (Work with objects) from the PDM menu, and pressEnter.

2. Type one of the options from the prompt for each of the fields: Library, Object
name, Object type, Object attribute, and then press Enter. PDM displays the list
of objects.

In the Remote Systems Explorer, object filters list a set of objects from your iSeries
server in the Remote Systems view. With the filter, you can use this list again later.

To access a list of objects in the Remote System Explorer:

1. In the Remote Systems view, expand your connection and then expand iSeries
Objects. Expand Work with objects. (You can also right-click iSeries Objects,
or your filter pool, and select New > Object filter.)

2. Expand Work with objects. (You can also right-click iSeries Objects, or your
filter pool, and select New > Object filter.)
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L& Remote Systems X

£ 2) | B85 -

[»

=14 Mew Connection

LB l'a ISEries...
"] Connection created successfully, E

@ Windows...

& Linux..,

w1 {} Power Linux...

B unie Unix...

BBy ALX...

=B Local...

E} Local [%

- s400a
= En iSeries Cbijects
e + 2 r

[ %4 Work with members. ..
o "ﬁ’» Library list
o] ﬁ:%» User libraries
= W Team Library List

&% iseries Commands

=88 Series Jobs -

B ¥ IFS Files -
L oo BV SR 15
4] | A

Note: Expanding Work with objects corresponds to the WRKOBIJPDM
command in PDM.

3. Browse, specify, or select from the Library drop-down list the library that
contains your objects.

4. Enter a generic or specific object in the Object field, or click Browse to select
one. The default is * (asterisk), and you can use up to ten characters. You can,
for example, enter P* to list all objects that start with P.

@new x|
Object Filter
= s e 1
Create a new Series object filter -y,

Library: |RSELABxx L—I ﬂ Browse, ., I
Object: |F‘"‘ ;] d Browse, ., |

Object type: | *
Object attribute; | *

Mare Types=> I

< Hack I MNext > I Finish | Cancel I

5. To define object types, you can browse, specify, select from the drop-down list,
or click More Types to select from all known object types.

6. To define object attributes, you can browse, specify, or select from the
drop-down list. You can only enter a single object type and attribute pair per
filter, until you change a filter to add more filter strings (see: Modifying a list
of items by modifying a filter).
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7. Click Next.
8. Enter a name for your filter.

@rew x|

Object Filter
Mame the new filter -"1 M

Marme the new Filter o 14

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appear in the Remote Systems view, and will be expandable,

Filter name: | P Objects]|

I Oy create filter in this connection

Select 3 profile ko own the new Filter, This determines if it is unique to you, or
sharable by the team, It will be placed in the default filker pool for that profile.

Owner profile: ]mstackh?tp j

<gack | mext> [ Fnsh |  cancel |

9. Select the Only create filter in this connection check box if you want the
filter to display only in your current connection. Otherwise, it displays in all
your connections.

10. Select the profile you want to use for this filter. You can use an individually
created profile to keep your work private or the team profile to share with
others. In this instance, use your default private profile.

11. Click Next to see more text information about the filter, or click Finish. You
can see your new object filter in the Remote Systems under iSeries Objects.

.5 Remate Systems X

£ AEEE
B E Local... i

- l;? Local

2§ s400a

B ﬁ-’u ISeties Objects
- ﬁ ‘Work with libraries. .
| Af' Wark with objects. ..
-bv| Filter created successfully Exp
@ Work with members. .
# -'ﬁ'a Library list
& ;:'? User libraries
'J i%b Y leranas

H-H PAYROLLCZ."pgm.CbIle
[ [£] PAYROLLD,*pgm, cblle
- [F PAYROLLG.*pgm.rpgle
&-& PRIMST. *file.pf-dta

+:| ﬁ' Team Library List
[+ 5k iseries Commands

£} ﬁ iSeties Jobs
-y IF5 Flles
T Qshells =
4| | 3

You can also search for iSeries member strings if you have a number of member

filters and you want to know which one includes a particular string you remember

Chapter 4. Objects, libraries, files, and members on the iSeries server
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defining. To search for member strings, either press CTRL+h or click Search >
Search from the menu bar. Click the iSeries Search tab, specify the search string
and any other criteria in the dialog box, and click Search.

Viewing a list of members
To view a list of members in PDM:

1. Select option 3 (Work with members) from the PDM menu, and press Enter. Or
type WRKMBRPDM in the command line and press Enter.

2. Type one of the options from the prompt for each of the fields: File, Library,
Member name, Member type, and then press Enter. PDM displays the list of
members.

In the Remote Systems Explorer, member filters list a set of source and data
members from your iSeries server in the Remote Systems view. With the filter, you
can use this list again later.

To view a list of members in the Remote System Explorer:
1. In the Remote Systems view, expand your connection and then expand iSeries
Objects.
2. Expand Work with members. (You can also right-click iSeries Objects and
select New > Member filter.)

: | =
g B O =] & w
H: & | | i =

| Connection created successfully, E_:-_]
| @y Windows...
Lo L.

P Q Power Linux,..
i [®-unix Unix..,
BBy AKX,
- =3 Local...
®-Ef Local
=K s400a

) & iSeries Objects

-8 Work with libraries. ..
. H i .

..... W Library lis
E i;‘v User libraries
i+ i=:'v ¥ Libraries
] T..'%‘v P Ohjects
i+ ﬁ Team Library List A
i+l & iSeries Commands
B ﬁ iSeries Jobs
- ¥y IFS Flles
% Gshells =

4 I >

Note: Expanding Work with members corresponds to the WRKMBRPDM
command in PDM.

3. Browse, specify, or select from the Library drop-down list the library that
contains your source members.

4. Browse, specify, or select from the File drop-down list the file within the
library that contains the appropriate source members.

5. Enter a generic or specific member name in the Member field. The default is *
(asterisk), and you can use up to 10 characters. You can, for example, enter
:PAY=* to list all members that start with PAY.
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10.

11.

(Optional) To select a specific member type, enter the type in the Member

type field, or click More Types to select from all known object types.

Use the check boxes to select whether you want to list source members, data
members, or both. Select at least one check box, and then click Next.

x
Member Filter
Create a new [Series member filter *1 N
=) J
Ubrary: | RSELABxx |4 Browse. . |
File: |QRPGLESRCP _:j :‘ Browse, .. |
Member: | PAY] =14 Browse. .. |
Menber type: | * ~| :I Browse. .. |
Mare Types>> I

5

¥ Source members

[T Gata members

< Back I Mext > I Finifsh Caricel

Enter a name for your filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.

(Optional) Select the Only create filter in this connection check box if you

want the filter to display only in your current connection. Otherwise, it
displays in all your connections.

Select the profile you want to use for this filter. You can use a personal profile

to keep your work private or the team profile to share with others. In this

instance, use your default private profile.

Click Next to see more text information about the filter, or click Finish. You
can see your new member filter in the Remote Systems view under iSeries

Objects.
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= A 3|l

L] Connection created successfully, E:_]
LB @ windows...
L@ Linux..,
PoEe A Power Linux,..
| [ unie Unix..,
By ALX...
- =3 Local...
I‘ Ef Local
=B s400a
= #lﬁ iSeries Objects
-8 Wwork with lbraries. ..
i+ ;f‘Wnrk with objects. .,
=] ‘:’E" Work with members...
E /| Filter created successfully. Exp
g ﬁ\ Library list
& }:‘»« User libraries
o] i"‘v’ ¥ Libraries R

!ﬂ g‘i" P Objects

[y PAYROLL.rpgle
-y PAYROLLG rpgle

+' ﬁt Team Library List =
P e e e e
4| i 3

Tip: You can search for iSeries member strings. You can either press CTRL+H or
click Search > Search from the workbench menu. Click the iSeries Search
tab, specify the search string and any other criteria in the dialog box, and

then click Search.

Modifying a list of items (by modifying a filter)

You can change the properties for any filter by opening the filter’s properties page.
You can also add new filter strings to a filter from this page. For example, if you
have a filter that lists all RPGLE source members, you can add an additional filter
string that will display all CBLLE source members as well.

To change a filter:

1. In the Remote Systems view, expand your connection name, and then expand
iSeries Objects to view the list of your filters.

2. Right-click the filter you want to change and select Properties.
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= | Kefresh

_!-':E'Rer_note Systems X

Expand +
45 & | Callapse .
; | Connectiol .
W@ Windows... g
* .& Lirs.... 1 IREARTaN:
€] _ﬁ Power Linux,..
¥t UNIX, 1 =i opy
By ALK, 4 Move...
® El Local... X Delete..
#-[El Local ’
=B s400a S eein

= 53;_-, iSeties Objects
-3 work with <. Move Down
- Work with
-5 Work with £ Show in Table

=

[F-ag Librarylist o~~~

22 ﬁ:# User librar |
Tasks |

|
Library F

Bl Libraries
g P Objects
ﬁ'r Payroll

3. In the Properties window, click Filter Strings to change the filter’s
specifications (what the filter lists from the iSeries server). For example, change
the value in the Library field. Then click Apply.

* If you want to add extra filter strings for your filter, click New filter string
and complete the dialog box. Then click Apply.

_iolx
Fikter Infarmation | Filter Strings |
Filter Strings
Filter name: ¥ Libraries
Parent fiter pool: Msteckhto Fiter Pod

New filker string:

Library: | RY| jﬂ Browse. .. |
]

4. Click OK.

Deleting filters

Deleting a filter does not delete any elements that you manage with that filter. You
only delete your specific configuration for that filter.

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.
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£ &) | o change...

[ _& Linux. .

- 0y Power Lnux i Rename...

[# s Unie., li=] — Copy

By ALX... e Mokier.

#-El Local... =
CRCIP I o, |
= B s400a +

&l & iseries Obje U Move Up

i [ﬂ%Wnrkwl JLMmDum
.’f Work wi
U 5 work wi 5 Show in Table

i /| Filte By
! Find Str
¢ [ Library | Y-

Properties

P OE uev Payroll

| B Team Library List
iﬂ % iseries Commands
i+ ﬁ iSeries Jobs =

Mam

® *2, IFS Files =
‘rir Qshells = gg
< J Ml @

2. Right-click your filer and select Delete.

Applying options to an object

The actions that you can apply to an object are listed as options in PDM. For
example, in the options column, you can enter 2 to change, 3 to copy, 4 to delete,
and so on.

To see the available actions that can be applied to a particular item in the Remote
System Explorer:

1. In the Remote Systems view, expand the filter beneath iSeries Objects that
contains the item you want to work with.

2. Select and right-click on the item. A pop-up menu shows the list of options that
can be applied to the item.
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-4 New Connection

#-Ef Local

=B s400a
EI fﬂ iSeries Objects

5 wark with libraries. .,

2 ‘i\ ‘Work with objects. ..

’4';]' Work with members. ..

I’ ﬁ? Library list
53] ﬁ\ QSY¥S.*ib.prod-sys
=M QsYs2.*ib.prod-sys
- il QHLPSYS. Hib.prod-sys
B ﬁ' QUSRSYS, ¥ib.prod-sys

|+

53] ﬁ\ QGPL.¥ib, prod st fien X
- M, WFLABKX Mib.testusr S0 TO d
- Bk, WSSLABH:. Hib.prod-usi oo T »
l‘ p User libraries
E r’v P Objects :-;_ | Refresh
- [nb Payroll
! # ﬁ/ Teanm Library List :E:;:::i +
i+ @k iSeries Commands T
a i5eries Jobs [ Rename. ..

[#-¥y IFS Files

G Qshells Copy
% Paste

% %€ Delete...

Add Library List Entry...
7 Remave From Library List
A Move Lp In Litrary List
<4 > Move Down In Library List
«1+ Mave Wikhin Library List...

Show in Table
7 Find String. .
Change...
SavelB)...
Restore..,
User Actions L4

| Clproperties £2 . Remote Scratchpad

E 3
Property | value ]

Create iSeries Project

Applying an action to multiple objects

When you use PDM you can apply the same operation to more than one item at a
time.

To apply an action to multiple items in the Remote System Explorer:
1. Expand the filter that contains the items.
2. Select the items you want.

» To select consecutive items, click the first item, press and hold down the
SHIFT key, and then click the last item.
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» To select non-consecutive items, press and hold down the CTRL key, and
then click each item.

» To select all the objects in the window, on the Edit menu, click Select All.
3. Right-click and select the action to apply to these items from the pop-up menu.

s

Displaying the description of objects
When working with PDM, you can display the following information about an
item;
1. Item size
2. Time and date the item was created
3. Time and date the item was changed
4. Time and date the item was last saved
5. Time and date the item was last restored

To display the description of an item in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

2. Expand your filter that contains the item you want to see.
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roperties for RSELABXX

3. Right-click on the item and select Properties from the pop-up menu.
4. Under Advanced Info, you can view the details of the item.
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Chapter 5. Working with items

You can use the Remote System Explorer to modify items, item features and item
attributes. In this section, you can see how easy it is to modify iSeries items using
the Remote System Explorer and to have the powerful prompt wizards guide you
to properly complete the action you want.

Creating items

To create an object in PDM:

Select option 5 (Programming) from the main menu.

Select option 2 (PDM).

Select option 2 (Work with objects).

Press Enter to bypass the Specify Items to Work with page.

Press F6 in the Work with objects screen to list all the create commands.

Type the command number in the command line and Press Enter.

At the Create prompt, type the information and press Enter to create an object.

N o g wDdhE

Creating source physical files

In the Remote System Explorer, you can create new source physical files in the
iSeries Objects subsystem or the iSeries Commands subsystem. The advantage of
the iSeries Objects subsystem is that you can navigate through your libraries to the
location where you want to create the file, and the advantage of the iSeries
Commands subsystem is that you can specify more parameters (for more advanced
users).

Method 1: To create a source physical file in the iSeries Objects subsystem:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Obijects > Library list.

2. Right-click the library in which you want to create the source physical file, and
select New > Source Physical File.
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3. Enter the name of the source physical file you want to create, or click Browse
to retrieve a source physical file from a specific library. If you browse to an
existing source physical file, you need to rename it after it appears in the File
field.

4. Enter the record length for the source physical file.
5. (Optional) Add a description in the Text field.

6. (Optional) Click Next to define advanced features for your source physical file,
such as Authority, Coded character set ID, or ICG data.

7. Click Finish. You can see your new source physical file under the library you
selected.

Method 2: To create a source physical file from the iSeries Commands subsystem:

1. In the Remote Systems view, expand your connection, and expand iSeries
Commands > Create source file.

38 Transition Guide: PDM to RSE



& New Connection
B Local
B sq00s

IFJ--E’-D iSeties Cbijects

-F-#

&l ?E Work with libraries. ..
w2 Work with obiects, .,
- Wwork with members. .

.l

- 5 Your command(s)...

# % Add fbrary to brary list

g Change current library
-5

et Create source [ e
* Create source member
¥ Create duplicate object

- 38 iSeries Jobs

¥ty IF5 Files

2] 57;’-/ Remove library From library lisk
- , = e

=

2. Specify or select parameters for the file. Click Advanced for extra parameters.

3. Click OK.

Creating message files
In the Remote System Explorer, you can create message files in libraries on your

iSeries server, similar to the CRTMSGF command in PDM, which creates a message
file for storing message descriptions. You can add message descriptions to the

message file, edit your message descriptions, and display the descriptions in the

iSeries Table view.

To create a message file in the Remote System Explorer: :
1. In the Remote Systems view, expand your connection, and then expand iSeries

Objects > Library list.

2. Right-click the library in which you want to create the message file, and select

New > Message File.
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3. Enter the name of the message file you want to create, or click Browse to select
a message file from a specific library. If you browse to an existing message file,
you need to rename it after it appears in the Message file field.
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6.

(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your message file, such as
authority, coded character set ID, or file size.

Click Finish.

Creating data queues

In the Remote System Explorer, you can create data queues in libraries on your
iSeries server, similar to the CRTDTAQ command in PDM.

To create a data queue:

In the Remote Systems view, expand your connection, and then expand iSeries
Objects > Library list.

Right-click the library in which you want to create the data queue, and select
New > Data Queue.

1.

7.
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Enter the name of the data queue you want to create, or click Browse to select
a data queue from a specific library. If you choose to an existing data queue,
you need to rename it after it appears in the Data queue field.

(Optional) Alter the size of the data queue if necessary. The maximum length is
64512.

(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your data queue, such as
authority, force to auxiliary storage, sequence, queue size, and auto-reclaim.

Click Finish. You can see your new data queue under the library you selected.

Creating data areas

In the Remote System Explorer, you can create data areas in libraries on your
iSeries server, similar to the CRTDTAARA command in PDM.

To create a data area:

1.

In the Remote Systems view, expand your connection, and expand iSeries
Objects > Library list.

Right-click the library in which you want to create the data queue, and select
New > Data Area.
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Enter the name of the data area you want to create, or click Browse to select a
data area from a specific library. If you browse to an existing data area, you
need to rename it after it appears in the Data area field.

Select the type of data area you want to create
(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your data queue, such as
authority, length information, or the initial value.

Click Finish.

Creating members directly in the iSeries Objects subsystem

You can create a new member in the Remote System Explorer using either the
iSeries Objects subsystem or the iSeries Commands subsystem. The advantage of
the iSeries Objects subsystem is that you can navigate through your libraries and
files to the location where you want to create the member, giving the member
location a context. The advantage of the iSeries Commands subsystem is that you
can specify more parameters (useful for more advanced users).

Method 1: To create a member from the iSeries Objects subsystem:

1.

In the Remote Systems view, expand your connection, and expand iSeries
Objects > Library list.

Select and expand the library and source physical file in which you want to
create a member.

Right-click the source physical file and select New > Member.
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Enter the name of the member you want to create, or click Browse to retrieve a
member from a specific library and source physical file. If you browse to an
existing member, you need to rename it after it appears in the File field.

Enter the member type or select from the available items in the list.
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6. (Optional) Add a description in the Text field.
7. Click Finish.

Method 2: To create a member from the iSeries Commands subsystem:

1. In the Remote Systems view, expand your connection, and expand iSeries
Commands > Create source member.
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2. Specify or select parameters for the member. Click Advanced for extra
parameters.

3. Click OK.

Deleting Items

To delete an item in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

2. Expand your filter that contains the item you want to delete.
3. Right-click on the item and select Delete from the pop-up menu.
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Renaming Items

To rename an item in the Remote System Explorer:

1.

In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

Expand your filter that contains the item you want to rename.
Right-click on the item and select Rename from the pop-up menu.
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Copying items

You can copy and paste files, objects, or members not only between libraries and
objects on the iSeries server, but between different servers as well. For example,
you can copy one or more files from one library in your iSeries server to another,
or from your iSeries to your Linux server. However, there are guidelines for what
kinds of items you can copy and paste. You can copy and paste source physical
files and libraries between different places on your iSeries server, or from one
iSeries server to another, but you cannot copy them to a universal server, such as a

UNIX or Windows server.

To copy and paste items:

1. In the Remote Systems view, expand the two connections (that represent the
two servers) until you see the item you want to copy and the location on the
other server where you want to paste the item.

2. Right-click the original item and select Copy.
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3. Navigate through the directories and files until you find the place where you

want to paste the item.

4. Right-click on the directory into which you want to paste your item, and select
Paste.
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Drag and drop action

The drag and drop action supports files, items, members and filters, but not
libraries. You can drag and drop filters from one subsystem or filter pool to
another. However, if you drag a filter into another filter, the target filter strings are

combined with the filter strings from the first filter.

To drag and drop items:

1. In the Remote Systems view, expand your connection(s) until you can see the

item you want to copy and the location where you want to paste the item. Or,
open two views that contain the item and the destination.

2. Click the item once to select it, hold down the left mouse button while you
drag the item to the location you want, and then release the button.
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Creating a program

You can compile your iSeries members in the Remote Systems view. The pop-up
menu for source members includes compiler submenus with several commands for
various member types. A compiler name is an identifier for a compiler command
to run on a remote system. For example, the label CRTBNDRPG tells the iSeries
server to create a bound RPG program. Compiler names are only associated with
source member types: members (*MBR) and modules (*MODULE). For this reason,
you only see the options to compile when you right-click these types of elements.
There are two ways to compile: prompted and unprompted. Both compiler actions
invoke a submenu with a list of compiler names.

To compile source members from within the Remote Systems view:

1. Drill down to a source physical file member and right-click on it. You can select
more than one member to compile by holding down the CTRL key and
selecting the members (as long as they are compatible and from the same
iSeries connection).

options:
* Compile > CRTBNDRPG: This option creates a bound RPG program on the
iSeries server.

Choose Compile or Compile (Prompt) from the menu with the appropriate
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* Compile > CRTRPGMOD: This option creates an RPG module on the iSeries
server.

* Compile > Work With Compile Commands: This option creates or edits
compile commands. You can choose the profile and the source member type
that you want to work with from the drop-down boxes at the top of the
window, and add, change, and delete compiler names.

* Compile (Prompt) > CRTBNDRPG: This option creates a bound RPG
program on the iSeries server. You can specify or change options before
compiling the current file.
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* Compile (Prompt) > CRTRPGMOD: This option creates an RPG module on
the iSeries server. You can specify or change options before compiling the
current file.

* Compile (Prompt) > Work With Compile Commands: This option creates or
edits compiler commands. You can choose the profile and the source member
type that you want to work with from the drop-down boxes at the top of the
window, and add, change, and delete compiler names.

If there are errors, the iSeries Error List shows the results of the compilation. The
compiler names available in these menus are determined from the associated
compiler names for each source type, and from the profile used to define the
connection.

To compile a program:

1. In the Remote Systems view, drill down to a source physical file member and
right-click. You can select more than one member to compile by holding down
the CTRL key and selecting the members (as long as they are compatible and
from the same iSeries connection).

2. Select Compile > or Compile (Prompt) > and then one of the following:

» Select Appropriate Compile Command such as CRTBNDRPG: A compile
command associated with your selected source member type will display in
the pop-up menu for your convenience. For example, select CRTBNDRPG to
create a bound RPG program for a selected RPG file. If you want to use a
different compile command than one of the defaults, choose the second
option, described below.

* Work With Compile Commands: Select the profile and the source member
type that you want to work with from the drop-down lists at the top of the
window, and add, change, or delete associated compile commands. This
option is also helpful if you want to use a different compiler command for
your source member, other than the default command in the pop-up menu. If
there are errors, the iSeries Error List shows the results of the compilation.

Run program objects

You can run program objects in PDM in either batch mode or interactively,

depending on the value you enter in the Run in batch prompt on the Change

Defaults display screen. To run an object in PDM:

1. Type STRPDM

2. Select option 2 (Work with objects).

3. Type information into the Specify Items to Work with page to find the object.
Press F23 to view more options.

4. Type 16 (Run) in the Opt column beside the program object you want to run.

To run programs in the Remote System Explorer, either right-click on the iSeries
object and select Run from the pop-up menu, or expand iSeries Commands and
select Run Command. At the prompt, specify the command and the job
environment that the program should run in: Normal (Remote Systems server job),
Batch, or Interactive.

Running programs and commands

The Remote System Explorer is built so that you can run programs and commands
on the iSeries server. The iSeries Commands Log view displays any returned
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messages as your applications are run. You can select a program or command and
run it according to the type of application it invokes:

* As an iSeries Batch Application: This option uses the SBMJOB command to run
your application in the batch subsystem that is specified in your user profile.

* As an iSeries Interactive Application: For this option, your application runs in
the interactive job associated with the selected Remote System connection. If no
interactive job is associated with the connection, you are asked to use the
STRRSESVR command to associate the interactive job with the specified
connection.

* As an iSeries Application in the Remote System Explorer communication
server job: This option lets you run the program in the same job as the
communication server. This is useful if you use the communication server job to
set up your environment, your library list for example, and you need your
program to run in this environment.

* As an iSeries Multi-threaded Application: Use this option to run
multi-threaded applications. It creates a BCI job in QUSRWRK and runs the
application in that job. You can also use this option to run any batch application.
This option is only available for objects of type *PGM.

There are two distinct ways of invoking the Run action, with and without
prompting. If you run without prompt, the selected object is run in the selected
type of job with default values. If your program or command requires parameters,
use the prompt option.

Attention: When you run without prompting, a temporary launch configuration is
created with default settings as "My iSeries program to run”. In the Run
Launch Configurations window, you can rename the launch
configuration and save it for future use.

To run a program or command without prompting, select a program or command

and do one of the following

* In the Remote Systems view, select Run As from the pop-up menu.
* In the iSeries Table view, select Run As from the pop-up menu.

* From the workbench Run menu, select Run As.

* From the menu icon next to the Run push button, select Run As.

To invoke a Run Launch Configurations window (Prompt) for a specific program
or command, select that program or command and do one of the following:

* In the Remote Systems view, select Run (Prompt) from the pop-up menu.
* In the iSeries Table view, select Run (Prompt) from the pop-up menu.

e From the workbench Run menu, select Run....

* From the menu icon next to the Run push button, select Run....

In the Launch Configurations window, specify parameters for your application.

Editing members
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When you use PDM, you can edit a member only in a file that is a source physical
file. PDM calls the source entry utility (SEU), which you can use to edit the
member.

In the RSE, use the Remote Systems LPEX editor or one of the other editors to edit
your members. Many of the editing features offered in CODE for RPG, COBOL,

Transition Guide: PDM to RSE



CL, and DDS source, such as syntax checking, automatic uppercasing, program
verification, and so on, are available in the Remote Systems LPEX editor.

To edit source in the Remote Systems LPEX editor:

1. Drill down through your files in the Remote Systems view until you find the
member you want to edit.

2. Double-click the member, or right-click the member and select Open With >
Remote Systems LPEX Editor.

3. With your cursor in the source, right-click and select an option from the pop-up

menu. The available options depend on the type of file you are editing. See the
online documentation for more information about the LPEX Editor.
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1 Rename...

Tip: You can switch between files you have open in the Editor view by pressing
CTRL+F6.

Compiling Members

In both PDM and the Remote System Explorer, you can compile a member only if
the member is in a source physical file. When you compile a member, the
appropriate create command is called for the member type.

You can compile your iSeries members in the Remote Systems view. The pop-up
menu for source members includes compile submenus with compile commands for
various member types. A compile name identifies a compile command to run on a
remote system. For example, the compile label CRTBNDRPG tells the iSeries server
to create a bound RPG program. Compile names are associated only with source
member types: members (*MBR) and modules (*MODULE). For this reason, you
see compile options only when you right-click these types of elements. You can
compile with prompts or without prompts. Both compile actions invoke a submenu
with a list of compile names.

To compile source members from the Remote Systems view:

1. In the Remote Systems view, drill down to a source physical file member and
right-click. You can select multiple files by holding down the CTRL key and
clicking various members (as long as they are compatible and from the same
iSeries connection).

2. Select Compile > or Compile (Prompt) > and then one of the following:

» Select Appropriate Compile Command such as CRTBNDRPG: The pop-up
menu provides a compile command for the selected source member type. For
example, select CRTBNDRPG to create a bound RPG program for a selected
RPG file. To use a different compile command, choose the next option.
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* Work With Compile Commands: Select the profile and the source member
type that you want to work with from the drop-down lists at the top of the
window, and add, change, or delete associated compile commands. Use this
option if you want to use a compile command for your source member other
than the default associated compile command in the pop-up menu.

If there are errors, the iSeries Error List shows the results of the compilation.
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Chapter 6. Applying actions to objects

Here you can see how some object specific actions are handled using the Remote
System Explorer.

Comparing file members

You can compare file members by using option 54 (Compare file member) in PDM.
This option is valid for all member types.

To compare files in the Remote System Explorer:

1. Drill-down through your files in the Remote Systems view until you find the
member you want to compare.

2. Double-click the member, or right-click the member and select Open With >
Remote Systems LPEX Editor.

.15 Remote Systems X SRLCN | = E]” 1[ 82 outline 82 N 0
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3. To compare an open member to another member, click Edit > Compare >
Compare to file from the menu bar.
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Changing the type and description of members

To update the text description of a member in the Remote System Explorer:

1.

w

52

In the Remote Systems view, expand your connection, and then expand iSeries

Objects.

Expand your filter that contains the member you want to view.
Right-click on the member and select Properties from the pop-up menu.

Under Member Info, you can view the description of the member. Here you

can update the type and the text description of a member.
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@ Properties for PAYROLL s i =10] x|
m Member Info ‘

Mame: PAYROLL

File:: QRPGLESRC

Library: RSELABXY

Type:! [ RPGLE =
Attribute: SRC

Text: |

Status: oK

Creation date; June S, 2001 3:02:20 PM

Change date: June 28, 2005 2:30:26 PM

Save date: July 23, 2003 1:38:46 PM

Restore date: June 27, 2005 9:24:09 AM
Mumber of records: 497
Deleted records: 0

| oK I Cancel

Moving a library to the user part of a library list

This action moves a library within your library list. You can only move a library
that belongs to the usr (user) section of your library list. To determine what section
a particular library belongs too, look at the extension at the end of the library
name:

» User libraries end with prod-usr
* Your current library ends with prod-cur
» System libraries end with prod-sys

You can also determine the type of each library in the Properties view, or by
right-clicking the library and selecting Properties. The type is beside the Attribute
field.

To move a library within your library list:
1. In the Remote Systems view, expand iSeries Objects > Library list.

2. Right-click the user library you want to move and select Move Within Library
List.
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Select one of the radio buttons for where to position the library, for example,

Select a reference library from the drop-down list. For example, if you selected

Before in the previous step, and you select, for example, WSSLABXX as the

3.
Before.

4.
reference library, then you will place your library before the WSSLABXX
library.

5. Click OK.
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Removing a library from the user part of a library list

This action removes a library from your library list. Once again, you can only
remove a library that belongs to the usr (user) section of your library list.

To remove libraries from your library list:
1. In the Remote Systems view, expand iSeries Objects > Library list.

2. Right-click the user library you want to remove and select Remove From
Library List.
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Chapter 7. Searching for text strings on the iSeries server

You can search for text strings on your native iSeries server in the Remote System
Explorer.

This action corresponds to the FNDSTRPDM command in PDM, which searches
for strings in a member.

The option in the Remote System Explorer searches libraries and filters as well as
members. You can search the native iSeries file system from either the Remote
Systems view or the populated iSeries Table view. When the search is finished, you
can use the pop-up menu to perform actions against the items listed.

This option is flexible in that you can select multiple items, which can be of the
same or of different types. For example, you can select a source member from one
library and a physical file from another library, and search for the same string. You
can also select a filter and a library, and then search them together.

You can search either from a selection, or from the entire iSeries server. When you
search from a selection, you navigate through your libraries and files until you find
the item you want to search. When you search from the entire iSeries server, you
do not begin with any item. Your search is as broad as you want it to be, and you
can narrow the search by specifying certain libraries, files, or member names to
search.

To search for strings from a selection:

1. In the Remote Systems view, expand your native iSeries connection until you
reach the item that you want to search. Or, navigate through items shown in
the iSeries Table view. Select the containing item by clicking on the item.

2. Right-click and select Find string. Or, click Search > Find string from the
workbench menu.
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In the Find String window, specify the string that you want to search in the

Search string field.

Select the Case sensitive check box if applicable.

The Scope area displays the targets that you have selected. If you are searching
libraries or library filters, two check boxes beneath this area are enabled:
Source members (selected by default) and Data members. Select Data
members if you also want to search data members, which takes longer.
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W}, RSELABKX
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(" Between II_ and end of line

[
"

m Cancel I

6. If applicable, specify columns to search with the Columns radio buttons. By
default, all columns are searched.

7. Click OK.

To search for strings from the entire iSeries server:
1. Click Search > iSeries from the workbench menu.

2. In the iSeries Search tab of the Search window, specify the string that you
want to search in the Search string field.

@i Remote System Explorer - PAYRODLL.RPGLE - IBM Rational Software
File Edit Source Complle Mavigate | Search Project Run ‘Window Help

| o J % * 0 L % - '_,i._-sewd'l..: Chrl+-H

| N | & S7Fe.

el

3. Select the Case sensitive check box if applicable.

4. Use the Target area to specify the target that you want to search. The names
can be generic. If the file name is generic, the Source members (selected by
default) and Data members check boxes are enabled. Check Data members if
you also want to search data members, which takes longer.

5. If applicable, specify columns to search with the Columns radio buttons. By
default, all columns are searched.
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6. Click OK.

In the Remote Search view, you can view the strings and files that you searched
for, with the matches listed underneath as a tree.

To manipulate the set of search results:

* Right-click the parent items of the tree and select any of the regular Remote
Systems options, for example, Open With, PDM Options, Properties, and so on.

* Right-click any line beneath the parent search item in the tree
— Select Open with to lock and open the member in an editor.

— Select Browse with to open the member in an editor without locking the
member on the server.

* Double-click the parent or item to open the member with the cursor on the line
that was found.
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Chapter 8. Working with user actions (user options)

In Remote System Explorer, user actions are server commands that you define and
run on iSeries libraries, objects, jobs, and members. You can also define user
actions for folders and files in any remote UNIX, Windows, Linux, Local, or IFS
file system.

Each user action has several characteristics:
* A unique name.

* A command (that might have substitution variables). The user action specifies
how to run the command (normal, batch, interactive, or multi-threaded).

» Substitution variables that are replaced with contextual information when the
command is run.

* An optional comment used to describe the action in more detail.

» Various options to affect what happens when the command is run; for example,
whether to prompt first.

* One or more file types to scope what resource types apply to the action. For
example, a command to start SDA would be scoped to members of the DSPF
type. The action is shown only for remote objects, which is one of the specified
types.

Managing user actions (user options)

To create a new action or change an existing action in the Remote System Explorer:

1. In the Remote Systems view, expand your native iSeries connection, right-click
iSeries Objects, and select Work with > User actions. You can also right-click
on a file in one of your filters, and select User Actions > Work With User

Actions.
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2. Select Object action or Member action, depending on the type of action you
want to manipulate.

3. Type a brief label for the action in the Action name field.
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Type descriptive information about the action in the Comment field.

Type the workstation or iSeries command string to run when a user selects this
action. When your action is run, the command can use action substitution
variables so that you do not have to explicitly code command parameter
values. Click Insert variable to view and select valid variables.

Additional parameters

1.
2.

Select Edit to change the command entered.

Select Browse to search for and select command files (for example, sys
commands). The file name you select is reflected in the Command field when
you return.

Select Prompt to prompt the command currently entered in the Command area.

Select Refresh after to refresh the selected files after the command for the
action is run. This is useful if your command affects the information displayed
in the file list window for the selected files, for example, if your command
changes the type or description of a member.

Select Single selection only to show the action only when a single object is
selected.

Select Invoke once to collect the full names of all selected resources into a
temporary member that is named by substitution variables ML, MF, and MM.
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7. Select any named types from the Defined Types list and click Add to include
them in the Selected Types list. The action is available only if a file matching
one of these types is selected.

You can also view user actions by active profile for remote objects on the User
Actions cascade menu. You can see both actions that are shared by the team and
actions that are private. To enable this, select Cascade user actions and compile
commands by profile on the Remote Systems view. (Click the drop-down menu
from the Remote Systems view and select Preferences > Remote Systems).

Chapter 8. Working with user actions (user options)
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